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Preface 

 

Mikrodev MP201 and MP211 PLC series are programmable control devices that are used in a 

wide range of applications from process automation to building automation, from machine 

automation to telemetry applications. 

 

In this document, you can find information about the function block library components 

used to program Mikrodev MP201/MP211 series PLCs. 

 

Please follow our website www.mikrodev.com for the up to date version of the document. 

  

http://www.mikrodev.com/
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 About Mikrodev 

 

Since 2006, MIKRODEV has been developing and manufacturing industrial control and 

communication products. MIKRODEV serves the system integrators in the public and private 

sector, OEM and end users. 

 

Our products are manufactured complying with the quality standards required by the 

industrial automation industry and the quality of our products are proved on the field for 

many years 

 

MIKRODEV is one of the few companies in the world that has its own designed IEC 61131-3 

compliant library for its programmable logic control devices. In addition, the open, flexible, 

programmable SCADA solution developed by MIKRODEV is also available to customers. 

 

MIKRODEV products' performance and wide range of applications make them possible for 

customers to achieve faster, simplified and cost-effective results. 
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 WARNING! 

 

 Use the programming editor only for Mikrodev Certifed devices 

 When you change your physical hardware configuration, update your development to 

the appropriate version. 

 The developed program should be tested separately before taking to field service and 

should be shipped to the field after the tests are successfully completed. 

 Take all accident prevention measures and safety measures identified by local law 

 

 

Failure to comply with these rules may result in death, serious injury or 

property damage 
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1 ViewPLUS Editor 

 

1.1 Creating New Project 

To create a new project:  

 Select File>New File or Project > Mikrodev SCA Project 

  

 

 Select project name and location. 
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 After entering the database username and password, you can verify the password by 

clicking the "Test Connection" button (if you will use PostgreSQL database and the 

PostgreSQL database is not installed on your system, you need to download and 

install the relevant version by clicking on "Download PgSQL" link. Likewise if you will 

use Oracle database, you need to install Oracle database on your system and 

download oracle runtime from here.) 

   

http://www.mikrodev.com/downloads/viewplus/windows/oracle_runtime.zip
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 The visual parameters such as screen color, default page size are set. 

   

 If you are going to use the SVN version control tool on the next page, the settings 

will be adjusted accordingly. 
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 A new project is created by pressing the "Finish" button. The newly created project 

consists of 2 files. These are the files with the extension "scapro" where the project 

configuration parameters are stored. You do not need to make any changes to this 

file. The other file that is automatically created is the file named "intro.sca". You can 

design the main screen on this page. 

   

 On the far left is navigation buttons that allow you to navigate through the editor's 

basic interfaces. Using these buttons, you can switch between the SCADA Editor 

view, Projects view and the Tag/channel Editor view. At the bottom of the navigation 
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buttons is the project selector. If more than one project is open at the same time on 

the editor, this button can be used to switch between projects 

 

1.2 SCADA Editor View 

1.2.1 Sidebar 

The sidebar is available in the SCADA Editor view. Use the sidebar to browse projects, files and 

insert components.  

Project files and components are controlled using panes on the left side of the editor. You can 

also filter and search the project files via the search box at the bottom of this panel. At the 

bottom left of the panel is a button that allows you to hide and show panels.  
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You can select the content of the sidebar in the sidebar menu:  

 Projects shows a list of projects open in the current session. 

 Open Documents shows currently open files. 

 File System shows all files in the currently selected directory. 

You can change the view of the sidebar in the following ways:  

 To toggle the sidebar, click ￼ (Hide Sidebar/Show Sidebar) or press Alt+0 (Cmd+0 

on macOS). 

 To split the sidebar, click ￼ (Split). Select new content to view in the split view. 

 To close a sidebar view, click ￼ (Close). 

1.2.2 Components 

ViewPLUS SCADA offers components in different types for visualization of the displayed data. 

These are; basic components, timers, graphics, database query and text components.  
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The basic components are located in the "SCADA Components" pane in the left panel of the 

Editor. The other components can be created using the "components toolbar" on top of the editor 

window.  

 

 

1.2.2.1 Basic Components 

Using the "Component Manager", different objects that the user has defined can be added . To 

insert a component to the current page, press the left mouse button on one of the components in 

the panel, then press the desired position on the scene with the left mouse button again and the 

component is added.  

  
 

To change the size of the added component, you can move the triangle icon in the lower right 

corner of the component with the mouse. "Object Properties Panel" is used to change the 

advanced properties of the component.  

1.2.2.2 Text Component 

The text component is used to display text in different fonts, colors, and formats. Used for fixed 

text. You can change the formatting of the text in the "Format" tab in the toolbar.  

  
You can show dynamic content on text component. Please refer to Basic Scripting.  
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1.2.2.3 Timer Component 

You can control the "Timer Blocks" that you have added to the PLC project with Mikrodiagram 

software via the "Timer" component. By adding "Timer Tags" you have defined in the Tag/ 

Channel Editor to the timer component, users can change the timing settings through the client 

software.  

  

1.2.2.4 Chart Component 

Using the chart component, you can graphically view the data of the desired tags. Chart object 

displays graphs as lines or bar graphs. In the chart settings window, the chart's appearance, 

behavior, and parameters for the tags to be displayed can be set.  

While only the last values of the tags added are shown on the bar chart; historical values of tags 

can be displayed on the line chart.  
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 Chart View Type: Sets how the chart will work. 

Chart Component : Graphical representation of the added component.     

Link to Chart : The added component only acts as a button. A separate window chart display is 

shown when pressed.  

 Chart Type: Selective type for chart type 

Line Grid : The trend data of the defined labels are drawn with different colors on the same chart 

. With new data read from the field, the chart is updated once in a second.   Bar Chart: Defined 

tags are displayed in bar chart format. The chart is updated once in seconds.  

1.2.2.5 Database Query Component 

This component allows the client to retrieve some specific queries from the database. In the 

Database query settings window, parameters related to the tag to be queried, query type, range, 

update frequency, and component visibility can be set.  

Database Query Component  
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1.2.2.6 Table Component 

You can display the data in tabular form on the table component. You can add and remove new 

columns / rows to table via the table menu .  

  

1.2.2.6.1 Styling Table 

You can set font and color for cell text using the format toolbar on the top of the editor:  
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You can also change the appearance of the table itself using stylesheets. Here is a sample 

stylesheet for changing row colors:  

alternate-background-color:#AACA98; 
background-color: #D3E3D0; 

1.2.2.6.2 Formulas on Table 

You can use excell like formulation on table cells. Please refer to Basic Scripting for inserting 

tag values into formulas  

Supported functions are:  

SIN  
COS 
TAN 
COT 
FABS 
LOG 
LOG10 
SQRT 
POW 
ROW   
COLUMN 

https://support.office.com/en-us/article/SIN-function-cf0e3432-8b9e-483c-bc55-a76651c95602
https://support.office.com/en-us/article/COS-function-0fb808a5-95d6-4553-8148-22aebdce5f05
https://support.office.com/en-us/article/TAN-function-08851a40-179f-4052-b789-d7f699447401
https://support.office.com/en-us/article/COT-function-c446f34d-6fe4-40dc-84f8-cf59e5f5e31a
https://support.office.com/en-us/article/ABS-function-3420200f-5628-4e8c-99da-c99d7c87713c
https://support.office.com/en-us/article/LOG-function-4e82f196-1ca9-4747-8fb0-6c4a3abb3280
https://support.office.com/en-us/article/LOG10-function-c75b881b-49dd-44fb-b6f4-37e3486a0211
https://support.office.com/en-us/article/SQRT-function-654975c2-05c4-4831-9a24-2c65e4040fdf
https://support.office.com/en-us/article/POWER-function-d3f2908b-56f4-4c3f-895a-07fb519c362a
https://support.office.com/en-us/article/ROW-function-3a63b74a-c4d0-4093-b49a-e76eb49a6d8d
https://support.office.com/en-us/article/COLUMN-function-44e8c754-711c-4df3-9da4-47a55042554b
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PI  
SUM 
PRODUCT 
MIN 
MAX 
AVERAGE 
MEDIAN 
MODE 

1.2.2.7 Image Component 

You can add images into your view by using image component. You can resize, rotate and flip 

the added image.  

1.2.3 Page Properties Panel 

  
The basic settings for the page are set via this panel  

Page Name 

The name you want to appear for the page in the left panel on the client screen for 

pages set as tabs. 

PageID  

System-assigned unique ID for each page. 

PageOrder  

Sets the order in which the page will appear in the left panel on the client screen for 

pages set as tabs. 

PageType  

https://support.office.com/en-us/article/PI-function-264199d0-a3ba-46b8-975a-c4a04608989b
https://support.office.com/en-us/article/SUM-function-043e1c7d-7726-4e80-8f32-07b23e057f89
https://support.office.com/en-us/article/PRODUCT-function-8e6b5b24-90ee-4650-aeec-80982a0512ce
https://support.office.com/en-us/article/MIN-function-61635d12-920f-4ce2-a70f-96f202dcc152
https://support.office.com/en-us/article/MAX-function-e0012414-9ac8-4b34-9a47-73e662c08098
https://support.office.com/en-us/article/AVERAGE-function-047bac88-d466-426c-a32b-8f33eb960cf6
https://support.office.com/en-us/article/MEDIAN-function-d0916313-4753-414c-8537-ce85bdd967d2
https://support.office.com/en-us/article/MODE-function-e45192ce-9122-4980-82ed-4bdc34973120


 

20 

 

 

MP201-MP211 / Programming Manual 

There are three different page types. "Tab" type pages appear as full screen on the 

client. At the same time, a button is created in the left-hand navigation panel that 

provides access to this page. Unlike the "Tab" for the "Linked Page" type, there is no 

button on the navigation panel. "Dialog" type pages are pages that are configured as 

popups to be opened in an action repository. 

GeoView  

Enables Google Maps api and shows the map. You should provide a map API key to 

be able to use this feature. First login to Google, go to Google API Key Console and 

select "Google Maps JavaScript API". After you get the key insert this into "Projects 

> Project File Paths > Map API Key" 

GeoCenter  

This option determines the initial position and zoom level of map when opened. It 

should be in that format :" Longitude,Latitude,ZoomLevel" 

Scale at startup  

Set how to scale scaling when the page is first opened on the client screen. 

CustomSize  

This option is checked if a different size will be used in the project settings instead of 

the default page size. 

Page Width  

Width for custom page size 

Page Height  

Height for custom page size 

BackgroundImage 

An image to be displayed on the client screen for the page in the left panel is 

displayed for the pages set as tabs. 

Add Scroll Text  

Adds a slip at the bottom of the page that allows you to show informative messages. 

AccessRights  

Different access rights can be defined to restrict access to the page. For users who 

do not have these rights, the page is not displayed. 

1.2.4 Layers Panel 

You can create or delete a new layer on the Layers panel. You can create a hierarchical layout on 

the page by creating components on the layers you create. You can make complex designs easier 

by hiding / showing layers. Another benefit provided by the layers is that the visibility of the 

layers at different zoom levels can be changed.  

https://console.developers.google.com/apis/library?project=api-project-923163475679
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1.2.4.1 Hide / Show Layers 

You can hide / show the layers you have added using the "Hide / Show Layer" option on the 

right-click menu of the mouse.  

  

1.2.4.2 Changing the Order of the Components in the Layer 

You can change the order of the layers that you have added using the "Bring Layer Components 

Front" or "Send Layer Components Back" options on the right mouse button menu.  

 

1.2.4.3 Hide / Show Layers According to Scale Level 

You can hide and show the layers defined on the page according to the scale level of the screen. 

On this scale, you can display more detailed information components when the scale level 

increases, but you can reduce the complexity of the design and make it easier to use by showing 

fewer components when the scale level increases. To do this, first select "Layer Properties" in the 

"Layers Panel"  

In the dialog that appears, there are two fields showing scale level parameters.  
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The layer will be visible between the two scale values to be entered here. If you define one of the 

values as "-1", the layer will be continuously visible in this direction regardless of the scale. For 

example, if values of "300" and "-1" are considered, the result will be like that: "Make the layer 

visible if the scale is greater than 3"  

The scale is smaller than '3':  

  
The scale is higher than '3':  

  
As you can see in the picture, when the scale value goes up to '3', the layer with the buttons 

becomes visible.  
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1.2.5 GIS Objects Panel 

 
You can edit your maps using this panel.  

Text  

The marker's name that will show up on map. 

Location  

The marker's location on map. It should be in "Lonitude,Latitude" format 

Icon  

Custom marker icon to be used on map 

Link to Page  

Select a page link to go when the marker is clicked. 

Add Marker Button  

Click on the map after selecting this button to insert a new marker 

Remove Markers Button  

Click on the map after selecting this button to remove markers 

Import Markers from GeoJson Button  

You can import markers from a geoJson file using this button. Go to 

http://geojson.io for more information. 

1.2.6 Object Properties Panel 

It is a panel that allows you to adjust the SCADA objects added to the page.  

http://geojson.io/
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Object Name  

A name that makes it easy to distinguish the object. 

ObjectType  

Represents the component type of the object. 

Geometry  

The position of the object on the screen is the parameters related to the scale and 

rotation. The top leftmost point of the page is positioned by accepting the point 

(0,0). Position value increases down and to the right. 

Constants  

Contains some settings related to the appearance of the object. 

Font X Offset : Used to add a horizontal offset to the position of the text to be 
printed on the object, relative to the upper left corner of the object.   
Font Offset : Used to add a vertical offset to the position of the text to be printed 
on the object, relative to the upper left corner of the object.   
Text Content : It is the field in which the display format of the "Text Label" 
defined in "Feature Tags" is configured. The "formatted" text entered here is printed 
on the component. The text to be entered must be in "printf text format". The 
following examples can be used for formatting: 
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Integer             :% d    => "1977"   
Add leading spaces  :% 10d  => "1977"   
Add a leading zero  :% 010d => "0000001977"   
Float numbers       :% 4.2f => "3.14" 
 
You can also display date/time values read from a 'seconds' source in desired format. 
To achieve this you can use "%dt(...)" notation. "%dt(...)" notation assumes that the 
tag value is in seconds: 
 
Date is : %dt(dd.MM.yyyy / hh:mm)  will be displayed as: 
 
Date is : 13.05.2017 / 12:24 
 
For different formatting styles please refer to Date/Time Formatting section 
Font Style Sheet : By setting the style sheet for the "Font Content" to be displayed, 
you can make settings such as font, font size and color -generator.html Here some 
examples can be found.   
Text Width : The maximum width of the text to be displayed on the component. 
 

 Events: Contains user interaction settings. 

Event Type : The parameter that determines when the event will be fired.              
MousePressed: Left mouse button press event    
MouseReleased: Left mouse button release event   Keystroke: Keyboard push 
event              
 
Event Action : When "Event Type" is triggered, the function to be operated is 
selected.                
SET           : Sets the value of "Target Event Tag" to "1".   CLEAR: Makes the value 
of "Target Event Tag" "0".    
CHANGE        : Makes "0" if "Target Event Tag" is "1" and "1" if it is "0".    
LOADVALUE     : If this function is selected, users will have a dialogue page in the 
client software where they can right-click on this component mouse to change the 
value of "Target Event Tag".    
NEXTPAGE    
PREVIOUSPAGE    
GOPAGE        : The page that was selected in "Go to Page" opens on the screen.    
GOLINK        : The link defined in "WebLink" is executed. 
      
Target Event Tag : Defines the tag that is the target of the "Event Action"   
Go to page : Page selection for "Go to page" action 

1.2.7 Tags Panel 

The values read from the labels selected from this panel are constantly updated according to the 

values read from the field.  

The labels defined here can also be used in macros. For each label, there are predefined "i, o, s, 

w" values. (Such as i1, i2, o1, o2 ..). You can see the default variable names of the tags by 

hovering over them with the mouse.  

https://mikrodev.miraheze.org/wiki/ViewPLUS_Appendix#Date.2FTime_Formatting
http://html-codes-generator.weebly.com/css-font-style
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Feature Tags  

 Image Index Tag: Shows the image index of the component to display instantly. 

Which images is in which index can be changed using the "Component Manager" or 

can be viewed under "Other Tab". 

 Text Tag: The value of the selected tag here is displayed on the component 

according to the form specified in "Text Content". 

 X Position: The horizontal position coordinate of the component is taken from this 

parameter. The top left corner of the page is the (0,0) coordinate. As you go to the 

right, the X value increases. 

 Y Position: The vertical position coordinate of the component's screen is taken from 

this parameter. The top left corner of the page is the (0,0) coordinate. The Y value 

increases as it goes down. 

 Width: The width value of the component is read from this label. 

 Height: The height value of the component is read from this label. 

 Rotation Angle: Rotation angle of the component with X axis. Gets value in 

degrees. 

 Text color: The color of the text to be displayed on the component is taken from 

this parameter. * 

 Mask color: The color of the mask that will be applied on the component is taken 

from this parameter. * 
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*Hex value of "112233" of the RGB color value defined as # 112233 is taken as the integer 

counter value. You can find some sample hex color values here. And you can use this tool to 

convert the color valueto integer.  

 Mask transparency: A value from 0-255 is taken from this label for the 

transparency value of the masquerade to be displayed.  

 Custom Labels: The 7 labels you select here will be available to the macros. 

1.2.8 Other Settings Panel 

  

 Limits: The maximum and minimum values by which users can change the "Target 

Event Tag" value through the client software are set using these parameters.  

 ToolTip: Adjust the content that will be shown when users bring the mouse over the 

component in the client software. You can show dynamic content on tool-tips . Please 

refer to Basic Scripting. 

 Macro: The script for the component is written in this box . For more information 

about macros, see the corresponding section.  

 Web link: If this field is defined as a web link, a menu entry will be created to access 

the related page from the right-click menu of the component.  

 Images: The images and index numbers defined for the selected component are 

displayed in this area. Index number expresses which image to show according to 

the data value read from the tag value of "Image Index Tag" at "Tags Panel". You 

can change the index display order of components from this panel 

http://www.w3schools.com/colors/colors_picker.asp
http://www.binaryhexconverter.com/hex-to-decimal-converter
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You can move up or down image indexes from the context menu opened by right clicking 
on the images. 

1.3 Projects View 

1.3.1 SCADA Pages 

List of all pages created on the project. This view gives detailed information about the created 

pages for the project.  
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1.3.2 Project File Paths 

Here are some important folder paths related to the SCADA project  
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1.3.3 View Configuration 

Default settings for SCADA pages are configured using this menu  

 

1.3.4 Client Options 

Various settings related to Client view can be done on this menu  
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1.4 Tag and Channel Editor View 

Channels and tags are special definitions that enable the SCADA software to access the data on 

the field devices. Channels include protocol definitions to provide communication with the 

device on the field and specific settings for this protocol. Tags consist of address definitions for 

the registers on the connected device. Alarm management is also done under this view.  

 

1.4.1 Channels 

Channels containing connection definitions can be created with a device in the field, as well as 

special channels defined by virtual connections such as macros or database queries.  

To create a new channel, open the "Tag Channel Editor" tab, press the right mouse button on any 

channel, and select "New Channel" from the popup menu.  

In the dialog that is opened, necessary adjustments can be made about the new channel.  

 

 

1.4.1.1 Modbus TCP Channel 

You must create a new Modbus Channel to communicate with field devices over TCP using 

ModBus protocol.  
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Select "Modbus TCP" as the "Protocol Type" in the dialog for creating a new channel  

 Channel Parameters  

- Server Adress  

The IP address of the device you want to connect to 

- Server Port   

Modbus connection port information of the device 

- Response Timeout   

It is time value, the Modbus slave waiting for the device to respond after each 

modbus request, in milliseconds. If no response is received from the slave device 

during this time, a new request is sent. 

- Connection Timeout   

It is the time value in milliseconds to wait until a new connection attempt is made 

after the request to connect to the device is sent. Typically in GPRS or 3G networks 

this time may be slightly longer than TCP. 

- Frame Timeout   

It is the time value in miliseconds to be waited until the next request is sent, after 

receiving a response from a Modbus request. 

For detailed information on Modbus configuration check here.  

 Tag Parameters  

- Function Code  

The IP address of the device you want to connect to 

- Device Address  

Modbus protocol device address 

- Variable Address  

Modbus variable address 

- Variable Size  

The size of the variable in the identified address 

- Variable Type   

The type of the variable in the identified address 

1.4.1.2 IEC 104 Channel 

You must create a new IEC 104 Channel to communicate with the field devices over TCP using 

the IEC 104 protocol.  

 Channel Parameters  

https://mikrodev.miraheze.org/wiki/Special:MyLanguage/ModbusAyarlama
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- W   

ACK(acknowledge message) sending frequency(sends ACK after W packets) 

- K    

The maximum allowed number of unacknowledged packets 

- T1  

ACK timeout duration for ASDU packet 

- T2    

If no new data will be sent after this time, an ACK is sent 

- T3    

Timeout period for test frame 

- General Interrogation   

GI message sending frequency 

- Clock Synchronisation   

CS message sending frequency 

- Timezone GMT   

Timezone information of server computer 

 Tag Parameters  

- Object Type 

... 

- InfoObjectAddress  

... 

1.4.1.3 SNMP Channel 

This channel is used to connect to SNMP devices. The NetSnmp library must be installed on 

your system in order for this channel type to work. You can download NetSnmp library 

from here  

 Channel Parameters 

 Server Address 

The IP address of the device you want to connect to 

Read Comunity 

The "Read Community" information that will be used to access device information. 

 Tag Parameters 

http://www/mikrodev.com/files/net-snmp-5.4.2.1-1.win32.exe
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1.4.1.4 Macro Channel 

This channel is used to create virtual tags and modify them with scripts.  

 Channel Parameters 

 - Frame Timeout 

The time in milliseconds that expresses the frequency of operation of the macro. 

 Tag Parameters 

1.4.1.5 Database Channel 

This is the type of channel used to make queries from SCADA's own database  

 Channel Parameters  

- Response Timeout 

The number of milliseconds that represents the frequency at which the database 

query is executed. 

1.4.1.6 Global Database Channel 

It is the type of channel used to connect to different databases to create custom queries and to 

pass these query results to project tags.  

 Channel Parameters  

- Response Timeout 

The number of milliseconds that represents the frequency at which the database 

query is executed. 

 Tag Parameters  

- Query  

The query expression to be executed in the database. This tag allows retrieving the 

first line returned from the query. The return values ??for this first row are written 

into tags respectively into the tags defined in the form of :{${32}, ${33} , ${34}, 

${35},....}: 

An example "Query" expression:  

WITH 
t1 AS ( 
  SELECT  data_value from logs.tag_log  l where tag_id=19 AND data_value IS NOT NULL 
ORDER BY logtime DESC limit 1 ), 
t2 AS ( 
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  SELECT  data_value from logs.tag_log  l where tag_id=20 AND data_value IS NOT NULL 
ORDER BY logtime DESC limit 1), 
t3 AS ( 
  SELECT  data_value from logs.tag_log  l where tag_id=29 AND data_value IS NOT NULL 
ORDER BY logtime DESC limit 1), 
t4 AS ( 
  SELECT  data_value from logs.tag_log  l where tag_id=26 AND data_value IS NOT NULL 
ORDER BY logtime DESC limit 1) 
  
SELECT t1.data_value data1, t2.data_value  data2, t3.data_value  data3, t4.data_value  
data4 
 FROM t1, t2 ,t3,t4; 
 
:{${32}, ${33} , ${34}, ${35}}: 

In the above PostgreSQL database query, the latest recorded database values of the tags 19, 20, 

29, and 26 are written into the tags with 32, 33, 34, 35 IDs, respectively.  

1.4.2 Tags 

"Tag" refers to point data that is read from the scene or created virtually by the system. Tags are 

defined under the channels and may have different properties depending on the type of channel 

they are in.  

1.4.2.1 Creating Tags 

To create a tag, open "Tag/Channel Editor Panel". Tag/Channel pane is on the top left of the 

screen. On the pane, right click on the channel in which you want to create a tag. On the context 

menu select "New Tag" action  

 
On the "New Tag" dialog write a name and description for the tag. The "tag name" must be 

unique; if you select an existing tag name, the system will prompt you a warning.  
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All tags created in the system have common properties that can be changed. These features are:  

1.4.2.2 General Tag Parameters 

In Use  

Tag is ignored by the SCADA server if the tag is not marked as "in use". The tag only 

becomes a definition in the system.  

Tag Name  

Each tag must have a unique name. Clear words and format should be used to 

describe the tag briefly 

Description  

Give a brief description about the tag 

Unit Name  

This is an optional property for the tag. It may be useful if you want to group tags by 

units on the field 

Tag Type  

This is an option for selecting "Schedule Tag" which is a special register reserved for 

calendar operations on Mikrodev devices. For more details see Mikrodiagram 

documentation 

1.4.2.3 Access Rights 

Reading: These are the rights that users have to have in order to see the tag values. Users who do 

not have the rights set here will not be able to read this tag value. Writing: It is the right that 
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users have to have in order to change tag values. Users who do not have the rights set here can 

not change this tag value.  

1.4.2.4 Variable 

Variable Type: The mathematical type of the variable  

1.4.2.5 Logging 

Log to Database  

If this option is not enabled, the tag value will not be logged on the system and 

historical values will not be visible. Also, historical values can not be viewed on the 

graph.  

Log on change  

Logging is done in case of tag value change. The type of change can be of the type 

"Percentage" or "Level" change.  

Percentage Change 

If "Percentage Change" is selected as the type of change; Logging is done if the tag 

value changes by the specified percentage value of the latest logged value. If value 

is set to "0", all kinds of changes are logged.  

Level Change 

If "Level Change" is selected as the type of change; if the tag value has changed by 

the specified value, logging is done. If value is set to "0", all kinds of changes are 

logged.  

Log Periodically 

If this option is enabled, the tag is continuously logged in the specified time period. 

Note: Logging type and tags to be logged must be carefully selected to avoid unnecessary 

increase in the size of the data to be stored. For example;  

 The tags should never be logged if you do not need historical values. 

 If a level or percentage change is selected for analog variables, a percentage or level 

appropriate to the data exchange pattern should be selected. 

 For digital values, "log on change" should be used instead of periodic logging. 

Data Logging Filter  

By using the data logging filter, you can prevent the measurement values ??collected from the 

field from being logged according to the filter you selected. So, you will be able to pick up 

possible false data  

 Only log when decreasing by maximum 
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This filter only allows logging of descending data below the entered maximum value. For 

example; If the maximum value is entered as 1000:  

188, 
225 ,(logged) 
1500,(not logged) 
350 ,(logged) 
400  (logged) 

In this example, the value '1500' is 1275 more than the previous value, so it exceeds the 

maximum value of 1000. Thus, is not logged.  

 Only log when increasing by maximum 

This filter only allows logging of incremental data below the maximum value entered.  

 Only log if value is in range 

This filter allows logging only if the value read from the field is in the specified range.  

 Only log if value is out of range 

This filter allows logging only if the value read from the field is out of the specified range.  

1.4.3 Alarms 

Alarms are an integral part of monitoring systems. ViewPLUS can create alarms for users 

according to field data and user's access rights.  

1.4.3.1 Creating Alarms 

To create an alarm, open "Tag/Channel Editor Panel". Alarms pane is on the bottom left of the 

screen. Right click on alarm pane. On the context menu select "New Alarm" action  
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On the "New Alarm" dialog write a name and description for the alarm. If you write an existing 

"class name" into AlarmClass, the alarm will be added to that class; if you write a new "class 

name" a new AlarmClass will created and the alrm will be added to that class  
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1.4.3.2 General Alarm Parameters 

 
- Alarm Name  

Give an apparent unique name for the alarm 

- Class Name  

The name of the class which the alarm belongs to. This is useful when grouping the 

alarms 

- Description 

Write a human readable explanation about the alarm 

- Value Tag 

The selected tag is the source of the alarm. Condition check will be made on this 

tag's value. 

1.4.3.3 Condition 

The conditions are evaluated according to the LIMIT and RANGE values on the right side of 

conditions pane  

- VALUE is equal to LIMIT 

The alarm is activated if the value of the tag is equal to "LIMIT" value.  

-VALUE is smaller than LIMIT 

The alarm is activated if the value of the tag is smaller than "LIMIT" value.  

- VALUE is greater than LIMIT 

The alarm is activated if the value of the tag is greater than "LIMIT" value.  

- VALUE is in "RANGE" 
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The alarm is activated if the value of the tag is in "RANGE".  

- VALUE is out of "RANGE" 

The alarm is activated if the value of the tag is out of "RANGE". 

1.4.3.4 Subscriptions 

Alarms should be assigned to users. A user can monitor an alarm only if the user is subscribed on 

that alarm.  

To add auser subscription on the alarm click on the Subscribed User Selection button.  

 

On the opened dialog, select the users which you want to be subscribed on the alarm  

1.4.3.5 Other 

- Require Acknowledge 

When this option is checked, if a user does not acknowledge the alarm, it will not 

disappear from alarms list if also alarm condition has gone away 

- Log into Database 

When this option is checked, the alarm states will be logged into database 

- Enabled 

This option activates/deactivates the alarm 
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1.4.4 Associating PLC and SCADA Projects 

As you develop your project, it becomes more important to associate channels in SCADA with 

PLC projects to prevent mistakes.To do this, you can specify the PLC project path in the upper 

right corner of the channel menu.  

 

1.5 Import and Export Operations 

There are different options for importing/exporting data from/to the project.  

1.5.1 Importing/Exporting Projects 

This wizard allows the user to import/export tags, channels, alarms, users and pages using a 

special file format(.scaexp).  

 Exporting Project 

After opening the project on ViewPLUS, on the File menu select "Export Project" option:  
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On the wizard window, select an output folder path for the ".scaexp" file to be generated. After 

that, when you push on the "Start Export" button, the wizard will create the ".scaexp" file  

 

 Importing Project 

On the File menu select "Import Project" option:  

 
On the wizard window, select the exported ".scaexp" file and a destination folder for the project 

files to be extracted:  
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After that, when you push on the "Import Project" option, the wizard will ask for database 

connection settings. The project database will be extracted into the configured database  



 

45 

 

 

MP201-MP211 / Programming Manual 

 
When the operation is complete succesfully, the project is ready to be used.  

1.5.2 Importing/Exporting Tags/Channels/Alarms 

Users can import/export tag/channel/alarm definitions from/to other projects.  

 Exporting Tags/Channels/Alarms 

After opening the project on ViewPLUS, on the Tools menu select "Export Tag/Channel 

Definitions" option:  
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When you confirm the export file path selection dialog, a file with ".tcf" extension will be 

created. You can use this file for importing into other projects.  

 Importing Tags/Channels/Alarms 

After opening a project on ViewPLUS, on the Tools menu select "Import Tag/Channel 

Definitions" option:  
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Important Note: This operation will overwrite existing tags. Thus, this operation may damage 

your project. Be sure that the exported tag id interval and local project's tag id interval do not 

intersect!  

1.5.3 Importing/Exporting Users 

Users created for a project could be exported to another project. Export/Import users menu could 

be used for that  

 Exporting Users 

After opening the project on ViewPLUS, on the Tools menu select "Export Users" option:  
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When you confirm the export file path selection dialog, a file with ".usr" extension will be 

created. You can use this file for importing users into other projects.  

 Importing Users 

After opening a project on ViewPLUS, on the Tools menu select "Import Users" option:  
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Important Note: This operation will overwrite existing users. Thus, this operation may damage 

your project. Be sure that the exported user id interval and local project's user id interval do not 

intersect!  

1.6 Macro Guide 

ViewPLUS supports macros in different types. Some of these macros work on the server side, 

while others work on the client side.  

The "macro tags" we define in the Tag/Channel Editor work on the server side. And it acts as a 

virtual tag. These macros work continuously on the server for the specified period.  

On the editor, it is possible to write separate macros for each object. These macros affect the 

display and behavior of that object and are only executed when the user is watching the object.  

 

1.6.1 Server Side Macro Tags 

Macros can take two processing elements at a time and are written line by line.  

Example:  

[ v0 = $1234 * 2]  

The operands that can be inserted into the macro are:  
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200 seperate variables(vo, v1, …., v199)  

Tag values (in "$1234" format)  

Constant values (Constant decimal values such as "234,12" can be added)  

[ v0 = $1234 * 2]  

v0 : The element to the left of “ = ” is the final result of the operation  

* : Operators like “+ , - , * , / , % , & , |, ^ , > , < , e ,b , k , n , ?“ could be used. Here:  

e: Equality check. The result is "1" if the operands are equal to each other, and "0" if not..  

n: Not equal check. If the operands are not equal to each other, the result is "1", otherwise it 

returns "0".  

b: Greater than check. If the first operand is greater than the second, the result is "1", otherwise it 

returns "0".  

k: less than check. The result is "1" if the first operand is smaller, and "0" if it is not.  

?: This is a special operand.  

[ v0 = 1234 ? 0]  : Returns the "RX Count" value of the tag with id 1234 (Read counter value)  

[ v0 = 1234 ? 1]  : Returns the "Read Time" value of the tag with id 1234 (the time at which the 

latest data was read from the field)  

[ v0 = 1234 ? 2]  : Checks whether there is communication with the device on which the tag with 

id 1234 is located  

[ v0 = 1234 ? 3]  : Checks whether there is a valid value in the tag with id 1234.(In general, when 

a SCADA server is started for the first time, it may be late to write a valid value in the tag, or a 

valid value of the tag may never be written)  

[ v0 = v0? 20]  : Writes server datetime into "v0" variable as the number of seconds that have 

passed since 1970-01-01T00:00:00  

[ v1 = v0? 21]  : Writes server year into "v1" as "v0" is the number of seconds that have passed 

since 1970-01-01T00:00:00  

[ v2 = v0? 22]  : Writes server month into "v2" as "v0" is the number of seconds that have passed 

since 1970-01-01T00:00:00  

[ v3 = v0? 23]  : Writes server day into "v3" as "v0" is the number of seconds that have passed 

since 1970-01-01T00:00:00  

[ v4 = v0? 24]  : Writes server hour into "v4" as "v0" is the number of seconds that have passed 

since 1970-01-01T00:00:00  
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[ v5 = v0? 25]  : Writes server minute into "v5" as "v0" is the number of seconds that have 

passed since 1970-01-01T00:00:00  

[ v6 = v0? 26]  : Writes server seconds into "v6" as "v0" is the number of seconds that have 

passed since 1970-01-01T00:00:00  

 

Attention: Here the tag id (1234 in the example) must be entered into the macro as a fixed value 

without "$" at the beginning  

Condition check:  

In the following example, it is checked whether the variable "v0" is equal to 1. If "v0" is equal to 

1, the macro executes the command on the bottom line (makes v1 value 555). If it is not equal to 

1, the line is moved down by the second parameter ("2") of the "IF" line. In this example, if "v0" 

is not equal to 1, the macro will go down 2 lines, that is, it will go to the return value ([E]) line 

and it will be finished.  

[ IF , v0 , 2]  

[ v1 = 555]  

[ E ]  

Another condition control operand is “NI” (NOT IF) . This checks the equality to 0 as the 

opposite of "IF"..  

In the following example, it is checked whether the variable "v0" is equal to 0. If "v0" is equal to 

0, the macro executes the command on the bottom line (makes v1 value 555). If it is not equal to 

0, the line is down by the second parameter ("2") on the "NI" line. In this example, if "v0" is not 

equal to 0, the macro will go down 2 lines, that is, it will go to the return value ([E]) line and it 

will finish  

[ NI , v0 , 2]  

[ v1 = 555]  

[ E ]  

In order for macros to work correctly , a return ([E] </ nowiki> return) must be added  

1.6.2 Client Macros 

Client Macros: This macro is written in the same format as the "server macros". However, only 

tags defined on that object can be used within those macros The tags defined on the tag tab of 

objects are used as follows:  

For each tag "i, o, s, w" values exist.  

i (in) : The raw value of the tag read from the field  
o (out):The value to display on the screen after the tag has been passed through the 
macro operations  
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s (set):The value set by the user for the tag  
w(write): The value to be written to the field device after the value that the user 
wants to set is passed through the macro operations  
i ---Macro---->o , s---Macro---->w  
If there is no macro operation 'i' is equal to 'o', 's' is equal to 'w'.  

1.6.3 Basic Scripting 

1.6.3.1 Display Tag Value 

You can add dynamic content on some components. To achieve this, you should use the '$' 

operator and 'braces' ($ {....}):  

 ${Tag_ID} 

As an example, you should write '${1234}' onto your component to display the value of a tag 

with the tag ID '1234' in your system.  

Tank Level is ${1234} 

this expression will be shown on the component like:  

Tank level is 78 

1.6.3.2 Performing Arithmetic Operations 

You can perform arithmetic operations using the '#' operator and 'braces'(#{....}). In the examples 

below you can see how you can do an arithmetic operation:  

 Example: 
 
Elapsed time is #{ ${1150} / 3600 } hours or #{ ${1150} / 60 } minutes 
 
Will be displayed as: 
 
Elapsed time is 5 hours or 300 minutes  
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2 ViewPLUS Server 

2.1 Overview 

The server software must be associated with a project in order to be able to run. When run from 

the Editor menu, the currently open project is used by the server. To run the server independently 

from the editor, select "Editor > Select Tools > Create Server Files to specify a folder and copy 

the server files to this folder. The "ServerEngine" script is used to launch the server. The 

"ServerEngine" script looks for a folder named "Project" in the same folder as the default 

behavior.  

The "Project" folder contains special files created by the editor. The main ones are; 

"MicrodevScada.ini", "Project.zip", "project pages with .sca extension", and component files. 

The server reads the information in the "MikrodevScada.ini" file, such as where to connect to the 

database and where to keep the records.  

When the SCADA server is started for the first time, the user may be prompted to enter the 

database connection information. The server can open a project in a different folder by using 

command line parameters below.  

“ServerEngine –dir “C:\Users\yg\Desktop\server\projectname“ ”  

-dir : Project folder  

Server Home Screen  

The main screen of the server has a console on which general system logs can be viewed. This 

console shows important server changes. More detailed server logs are saved in a separate file. 

When the "Start" button is pressed, the server tries to connect to the field devices. After the 

connection is established, the server opens a port to which clients can connect and waits for 

incoming connections. When the server starts reading data from the field, it records them on the 

database server as specified in the project settings. Instantaneous readings of field-readable data 

can be viewed on the tag monitoring screen.  
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Server Tag Monitor Screen '  

The instantaneous values on the tag monitoring screen can be filtered according to parameters 

such as tagID, tag name, channel name, device address.  

If there is a text "dced" next to the numeric data shown in the "Value" field, this 
indicates a connection problem between the device and the SCADA server 

Information about the protocol drivers running on the drive monitoring screen is given. 

Information about connection problems can be obtained from this console.  

The alarm screen allows you to observe the history of alarms generated in the system and the 

current alarms.  

2.2 Server Auto Start 

2.2.1 Windows Platform 

Follow these steps to start the server automatically (for a sample project named "TestProject"):  

 Create a shortcut to the desktop for the "ServerEngine.exe" program in the 

installation folder of ViewPLUS. 
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Shortcut Creation  

 Right-click the created shortcut and select "Properties". 

 Change the field marked "Target" to the following (Change the file path according to 

your system): 

C:\Users\<User Name>\TestProject" -start C:\Program Files 

(x86)\ViewPLUS\bin\ServerEngine.exe"  

 Then copy this shortcut to "C:\Users\<User 

Name>\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup". The 

server will now start automatically when the user logs in to the system. 

 Auto startup can be accomplished by copying the OperatorClient shortcut to 

"C:\Users\<User Name>\AppData\ Roaming\Microsoft\Windows\Start 

Menu\Programs\Startup". 

 

2.2.2 Linux Platform 

2.3 Email Server Settings 

E-mail can be sent in case of an alarm to the user whose "e-mail send option" is marked as active 

from the user manager. For this, e-mail configuration settings must be made on the server. In 

addition, the smtp server to be used should allow "less secure application access". The 

configuration file "ServerEngine.ini" where the e-mail server settings can be found in the 

following folder:  

C:\Users\<user name>\AppData\Roaming\Mikrodev\ScadaServer\<project 
name>\ServerEngine.ini  

In this file, the following variables must be set correctly under [SMTP]:  

[SMTP]  

SMTP_user =<email username> 
SMTP_pwd=<e-mail password> 
SMTP_host=<smtp server address> 
SMTP_port=<smtp server port> 
SMTP_mailDelay=<The time (in seconds) to wait for an e-mail to be sent after an alarm 
condition(in seconds)> 

You can use the this program to test the settings you have made.  

2.4 Create Server Runtime 

You can also run the developed SCADA project without installing ViewPLUS on a different 

computer. By selecting "Create Server Files" from the "Tools" menu for this, you can collect the 

files in a folder for project and server work. By moving this folder, it is possible to run your 

project on different server machines.  

https://support.google.com/accounts/answer/6010255?hl=en
http://www.mikrodev.com/files/smtp_test.rar


 

57 

 

 

MP201-MP211 / Programming Manual 

2.5 Advanced Settings 

log_server.txt:  

On Windows systems, it is located in the following folder:   
C:\Users\<username>\AppData\Roaming\Mikrodev\ScadaServer\<project name>   
It is the file where the detailed server logs are found 

log_serverstarter.txt :  

The file that contains logs of the server monitor software  

OperatorClient.ini :  

ServerEngine.ini:  

On Windows systems, it is located in the following folder:   
C:\Users\<user name>\AppData\Mikrodev\ScadaServer\<project name> 
[Login]> ServerAdr              : Database address 
 
[Login]> DbName                 : Database name 
 
[Login]> DbUserName             : Database user name 
 
[Login]> DbPassword             : Database password 
 
[Connection] > Port             : The default server port is 560. A different port 
can be selected by changing this parameter. 
 
[Logging] > IsLogging           : Data logging can be enabled / disabled(true/false) 
 
[Logging] > IsLoggingDısconnections: You can choose whether to log connection 
failures 
 
[REDUNDANCY]> ServerMode        : Determines the mode of operation. This value can be 
PRIMARY or BACKUP. When this mode is set to BACKUP, the server communicates with the 
PRIMARY server to form a redundant structure. 
 
[REDUNDANCY]> PrimaryIP         : The PRIMARY server IP address to which the server 
in BACKUP mode will connect is written in this field. 
 
[REDUNDANCY]> PrimaryPORT       : The port number of the PRIMARY server to which the 
server in BACKUP mode will connect is written in this field. 
 
[REDUNDANCY]> Timeout           : PRIMARY is the value in seconds that specifies how 
long the server will remain active if the BACKUP server is down. 

2.6 Parallel Redundant Working Mode 

ViewPLUS SCADA software can run in "Parallel Redundant Mode" on a server cluster 

consisting of several computers. In this case, the server downtime can be reduced to the 

minimum. Redundant mode servers must be on the same local area network.  
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2.6.1 Installation Steps 

 While ViewPLUS is running in this mode, every 2 servers (PRIMARY, BACKUP) must 

be able to access the project database over the network. 

 At the same time, project files must be present on the server computers and they 

must be up to date (same as each other). To ensure this synchronization, a version 

control tool such as SVN can be used or the files can be moved manually. 

 In order for the backup and main server to communicate, the main server must have 

port 51313 open on the computer. Make sure that this port is allowed in the firewall 

settings. 

 In the next step, the following configuration settings must be made in the 

ScadaServer.ini files on the primary server (PRIMARY) and the backup server 

(BACKUP): 

Primary server(PRIMARY):  

[REDUNDANCY] 
ServerMode=PRIMARY 
PrimaryIP=192.168.2.201 
PrimaryPORT=51314 
Timeout=60 
size=0 

Backup server(BACKUP):  

[REDUNDANCY] 
ServerMode=BACKUP 
PrimaryIP=192.168.2.201 
PrimaryPORT=51314 
Timeout=60 
size=0 

ServerMode: Specifies the backup operation mode. This value can be PRIMARY or BACKUP. 

When this mode is set to BACKUP, the server communicates with the PRIMARY server to 

create a redundant structure. PrimaryIP: The PRIMARY server IP address to which the server in 

BACKUP mode will connect is written in this field. PrimaryPORT: The port number of the 

PRIMARY server to which the server in BACKUP mode will connect is written in this field. 

Timeout: Is the value in seconds that specifies the time PRIMARY server is out of service before 

the BACKUP server become active.  

In the example, the IP address of the primary server (PRIMARY) is a fixed IP of 

"192.168.2.201". The IP address of the primary server in the system to be installed must be a 

static IP in this way, variable IP from a DHCP server should not be used. The port number set in 

PrimaryPORT can be set differently according to security requirements. In this case, the correct 

port number should be entered by modifying every 2 configuration files.  

After the configuration process is completed, first the primary and then the backup servers are 

started . From this moment on, the backup server will switch on and off in case of a shutdown, 

watching the primary server. When the primary server becomes active again, the backup server 

will stop itself by switching to the watching mode  
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2.6.2 Synchronization of the Project on the Backup Server 

When the backup server starts running, the server will use the files in the project folder. 

Therefore, if these files are not synchronized with the files on the main server, an older version 

of the project will be sent to the clients. A synchronization mechanism must be established to 

prevent this from happening.  

Assuming that the project files are on the SVN version control server as described earlier, you 

can provide automatic synchronization as follows  

 We create a batch script that will trigger SVN synchronization. In this example, the 

file name is updateSvn.bat. Modify the contents of the file according to the file paths 

in your system to make it like this: 

CD D:\MIKRODEV\Projects\DepoProject 

"C:\Program Files\TortoiseSVN\bin\svn.exe" update 

Every time we run this script, it will synchronize the project folder with that of the SVN server.  

 In the next step, this script will be configured to run at specific intervals. For this we 

will use the Windows "Schedule Tasks" tool. 

By following the steps below, the synchronization procedure will be run every 10 minutes. You 

can configure this time interval as you like.  

Task Scheduler  

Create a new task  

Timing Programming  

Set timing settings. In this example we choose to work once every 10 minutes.  

Script Selection  

Finally, associate the .bat file you created with the timer.  

If you confirm the timer, the backup server will synchronize itself every 10 minutes with the 

project on the main server.  

 

Retrieved from 

"https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&oldid=3152"  

2.6.3 Navigation menu 

2.6.3.1 Personal tools 

 Hata! Köprü başvurusu geçerli değil. 

https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&oldid=3152
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 Not logged in 

 Talk 

 Contributions 

 Create account 

 Log in 

2.6.3.2 Namespaces 

 Page 

 Discussion 

2.6.3.3 Variants  

2.6.3.4 Views 

 Read 

 View source 

 View history 

2.6.3.5 More 

2.6.3.6 Search  

Special:Search Search Go
 

2.6.3.7 Navigation 

 Main page 

2.6.3.8 ViewPLUS 

 Introduction 

 Editor 

 Component Manager 

 User Manager 

 Server 

 Client 

 Reporting 

 Data Manager 

 Smart Bill 

 Application Notes 

 Appendix 

2.6.3.9 Mikrodiagram 

 Introduction 

 Mikrodiagram Application Notes 

https://mikrodev.miraheze.org/wiki/Special:MyTalk
https://mikrodev.miraheze.org/wiki/Special:MyContributions
https://mikrodev.miraheze.org/w/index.php?title=Special:CreateAccount&returnto=ViewPLUS+Server&returntoquery=printable%3Dyes
https://mikrodev.miraheze.org/w/index.php?title=Special:UserLogin&returnto=ViewPLUS+Server&returntoquery=printable%3Dyes
https://mikrodev.miraheze.org/wiki/ViewPLUS_Server
https://mikrodev.miraheze.org/w/index.php?title=Talk:ViewPLUS_Server&action=edit&redlink=1
https://mikrodev.miraheze.org/wiki/ViewPLUS_Server
https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&action=edit
https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&action=history
https://mikrodev.miraheze.org/wiki/Main_Page
https://mikrodev.miraheze.org/wiki/ViewPLUS
https://mikrodev.miraheze.org/wiki/ViewPLUS_Editor
https://mikrodev.miraheze.org/wiki/ViewPLUS_Component_Manager
https://mikrodev.miraheze.org/wiki/ViewPLUS_User_Manager
https://mikrodev.miraheze.org/wiki/ViewPLUS_Server
https://mikrodev.miraheze.org/wiki/ViewPLUS_Client
https://mikrodev.miraheze.org/wiki/ViewPLUS_Reporting
https://mikrodev.miraheze.org/wiki/ViewPLUS_Data_Manager
https://mikrodev.miraheze.org/wiki/ViewPLUS_Smart_Bill
https://mikrodev.miraheze.org/wiki/ViewPLUS_Application_Notes
https://mikrodev.miraheze.org/wiki/ViewPLUS_Appendix
https://mikrodev.miraheze.org/wiki/Mikrodiagram
https://mikrodev.miraheze.org/wiki/Mikrodiagram_Application_Notes
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2.6.3.10 Tools 

 What links here 

 Related changes 

 Special pages 

 Permanent link 

 Page information 

 Cite this page 

 Get shortened URL 

 This page was last edited on 19 June 2017, at 23:03. 

 Content is available under Creative Commons Attribution Share Alike unless 

otherwise noted. 

 Privacy policy 

 About Mikrodev Documentation 

 Disclaimers 

 Terms of Use 

 Mobile view 

  

  

https://mikrodev.miraheze.org/wiki/Special:WhatLinksHere/ViewPLUS_Server
https://mikrodev.miraheze.org/wiki/Special:RecentChangesLinked/ViewPLUS_Server
https://mikrodev.miraheze.org/wiki/Special:SpecialPages
https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&oldid=3152
https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&action=info
https://mikrodev.miraheze.org/w/index.php?title=Special:CiteThisPage&page=ViewPLUS_Server&id=3152
https://mikrodev.miraheze.org/w/index.php?title=Special:UrlShortener&url=https%3A%2F%2Fmikrodev.miraheze.org%2Fw%2Findex.php%3Ftitle%3DViewPLUS_Server%26printable%3Dyes
https://creativecommons.org/licenses/by-sa/3.0/
https://meta.miraheze.org/wiki/Privacy_Policy
https://mikrodev.miraheze.org/wiki/Mikrodev_Documentation:About
https://mikrodev.miraheze.org/wiki/Mikrodev_Documentation:General_disclaimer
https://meta.miraheze.org/wiki/Terms_of_Use
https://mikrodev.miraheze.org/w/index.php?title=ViewPLUS_Server&printable=yes&mobileaction=toggle_view_mobile
https://creativecommons.org/licenses/by-sa/3.0/
//www.mediawiki.org/
https://meta.miraheze.org/wiki/
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3 ViewPLUS Client 

3.1 Client Overview 

Client software; allows end users to connect to the SCADA server via the internet or intranet, 

allowing them to monitor and control the prepared project.  

 
To connect to the SCADA server, you need to enter the user, password, server address and port 

information into the client software. You need to use "User Manager" to create a new user. When 

this information is entered correctly, an encrypted connection is established between the server 

and the client software, and the project main screen sent from the server is displayed on the 

client.  

The "page selector" on the left side of the client screen also shows shortcuts for pages that are 

defined as "SCADA Tab" in the editor. The appearance and order of the shortcuts shown here 

can be set on the editor. Besides these shortcuts, there are shortcuts with alarm panel and web 

view panel.  
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Access Rights  

Content shown on the client may differ depending on the access privileges of the user, the pages 

and the defined tags. Pages that do not corresponds with the access rights of the user will not be 

shown in the "page selector", or links that are directed to those pages will not work. If a visual 

element on the page contains a tag that the user does not have access to, the user is prevented 

from watching or controlling this item.  

3.2 Alarm Management 

To be able to access alarm management, the user needs to have related access right.  

3.3 Report Management 

To be able to access report management, the user needs to have related access right. Report 

Manager for Operator Client provides same functionality as "SCADA Reporter" tool. For details 

please refer to ViewPLUS Reporting  

3.4 Controlling Field Data 

According to the project structure, there are different types of objects you can control over client 

application. To be able to manipulate a field data, you need to have associated access rights for 

writing on the tag related with that object.  

Buttons 

Buttons work in a boolean style. They may work in toggle mode or only set/unset 

mode.  

Value settable Widgets 

https://mikrodev.miraheze.org/wiki/ViewPLUS_Reporting
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You can set some field values by right clicking and selecting "Set Value" option from 

menu. 
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4 ViewPLUS Reporting 

4.1 Overview 

You can use the Reporter to view and analyze trend data that is logged by the SCADA software. 

Reporting is done on 3 basic record types. These are tag logs, alarm logs and event logs.  

 
 

4.2 Tag Logs 

Tag log is the data that has been recorded, depending on the logging configuration of the tag. 

Output can be generated in different formats by filtering according to location, time and other 

parameters of the tag.  

 

4.2.1 Selection of Tags to Log 

On the tags selection screen, tags under a station can be grouped or all can be selected. If you use 

the tags option under the station, a list of all the stations appears.  
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Tags under the station can be listed by clicking on the station name.  

 
 

"All Tags" option is selected to make selection through all tags.  
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Filters can be made on the tag list in different ways according to the tag properties. Tags to be 

reported from the list in the left panel are selected by double clicking. The selected tags are 

displayed in the panel on the right. To delete a specific tag from the right panel, select the tag 

and press the "Delete" key on the keyboard. To delete all of the tags, select "Clear List".  

 

4.2.2 Viewing Tag Log 

When the report sheet is first opened, the values of the selected tags are displayed graphically for 

a specific time interval. "Table View" can be selected to display the data on table form . 

Different choices can be made regarding the time range and type of data shown.  
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4.2.2.1 Selecting a Time Interval 

The time range of the displayed data can be selected in 3 different ways.  

A) Interval : 2 dates are selected 
B) Within the last:  Hour, day, week, etc. are selected and the backward time from 
current date/time is calculated. 
C) On Time/Date: An exact date can be selected , or a time value could be added 
forwards or backwards to this date. For example, "This Day - 5", means "5 days ago". 
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If the date is selected and time unit is "Month"; the month of that date is selected 
as the time interval. 

 

4.2.2.2 Selecting Data Type 

The type of data to be displayed can be statistical value as well as the value of the data itself.  

A) All Data: Shown  the actual value of the data that has been logged 
B) Statistics: Displays the mean, total, maximum, minimum, change and median values 
of the data for the selected time periods. For example, if the hourly maximums in a 
daily time interval are selected, the time interval is divided into hourly slices to 
produce an output consisting of 24 points. 

 
 

4.2.2.3 Managing Charts 

Show/hide Legend button: Shows or shows the name of the plotted tag and descriptions that 

show line color in the upper right corner of the chart Add a New Chart: Adds a new chart object 

that you can compare the data in the main chart with the previous time periods. The added chart 

is displayed synchronously with the main chart according to the determined time interval.  
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If the data belonging to the selected item in the range defined on the chart is present, this data is 

indicated by a point. The points shown can be connected to each other in different ways. 

Underneath the chart is the charting properties menu for each individual chart. Through this 

menu, the following operations can be performed  

A) Show / hide chart: This line can be hidden and shown with this button 
B) Charged / unloaded: Below of the line related to the tag is filled in integral. It 
may be easier to compare with other tags in this way. 
C) Merge Points: The points indicated by the item data can be merged into different 
ways. 
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4.2.2.4 Saving Charts 

According to the selected parameters, the chart can be saved in an image file in "png" format. 

Use the "Save Chart " button in the left panel  

 

4.2.3 Exporting Data 

The data according to the selected parameters can be exported in various formats. For this, firstly 

the table view button is pressed to create a data table. By using the buttons "html, xml, xslx, csv" 

located at the top of the table view screen, the data in the table is converted to these formats and 

stored.  

 

4.2.4 Saving Filters 

The parameters selected to create the data can be saved, and then the same filter can be applied 

again when needed. The parameters created for this should be applied at least once (Apply 

Button). After doing this, select "Save this filter" and a name will be given to the filter.The filters 

are saved for user account. The user can reach these filters from any location. The saved filter 

can be applied from the saved filters menu on the right side of the screen. When the filters in this 

menu are copied by right clicking with the mouse, the content of the filter is copied to the 

clipboard. This copied content can be linked to objects on the SCADA Editor screen. When 

clicked on the related object on this screen, the report screen opens and the predefined filter is 

run.  

4.3 Creating Reporting Command 

It is possible to create the report output in the desired format by calling the created filters through 

the reporting command line. For this, it is enough to give the command parameters required for 

the reporting application. Using this feature, it is possible to create automatic reports at certain 

time intervals via the "Task Scheduler" of the Windows operating system.  

ScadaReporter.exe -database modpollread -user postgres -password laqhd -

server localhost -port 5432 -query twohours -format csv -output 

"C:\Users\yg\Documents\Reports\Last2Hours"  
-database   Name of the project database (same name as project) 
-user      Database user name 
-password  Database user password 
-server    Database ip address 
-port      Database connection port 
-tnsname   tns name for Oracle databases 
-format    Report output form. Possible values are html, csv, xlsx, xml dir 
-query     The name of the filter saved in the report. This parameter is required for 
the report command. If not given, we do not produce a report; The reporting interface 
opens 
-output    The path and name of the file to be exported. 
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5 ViewPLUS Appendix 
 

5.1 Working with Multi-user 

It is also possible for multiple users to work on the same project. The ViewPLUS project consists 

of 2 basic components as mentioned before. Project files and database. A version control 

application (such as SVN, Clearcase, Git ...) is needed so that project files can be synchronized 

among different users. The project database is kept on a central server and synchronization is 

provided if the users configure their projects to use this database.  

 

5.1.1 Synchronization with SVN 

A version control tool such as SVN can be used to synchronize project files on different 

computers, prevent conflicts, and backup historical project versions. ViewPLUS has an 

integration with SVN.  

 

5.1.2 PgSQL Database Remote Connection 

PgSQL does not allow access from the network as a security measure when the database is 

installed, it only allows connections from localhost. To ensure access to the database of users on 

the same network, the following steps should be taken:  

1) Add an exception to the firewall for the PgSQL port (5432)  

2) Add the following line to the pg_hba.conf file:  

  host all all 0.0.0.0/0 md5 

3) Add the following line to the postgresql.conf file:  

  listen_addresses='*' 

5.2 Date/Time Formatting 

These expressions may be used for the date part of the format string:  

Expression  Output  

d  the day as number without a leading zero (1 to 31)  

dd  the day as number with a leading zero (01 to 31)  

ddd  
the abbreviated localized day name (e.g. 'Mon' to 'Sun'). Uses 

QDate::shortDayName().  

dddd  the long localized day name (e.g. 'Monday' to 'Sunday'). Uses 

https://mikrodev.miraheze.org/w/index.php?title=Qdate.html&action=edit&redlink=1
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QDate::longDayName().  

M  the month as number without a leading zero (1-12)  

MM  the month as number with a leading zero (01-12)  

MMM  
the abbreviated localized month name (e.g. 'Jan' to 'Dec'). Uses 

QDate::shortMonthName().  

MMMM  
the long localized month name (e.g. 'January' to 'December'). Uses 

QDate::longMonthName().  

yy  the year as two digit number (00-99)  

yyyy  the year as four digit number  

Note: Unlike the other version of this function, day and month names must be given in the user's 

local language. It is only possible to use the English names if the user's language is English.  

These expressions may be used for the time part of the format string:  

Expression  Output  

h  the hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display)  

hh  the hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display)  

H  the hour without a leading zero (0 to 23, even with AM/PM display)  

HH  the hour with a leading zero (00 to 23, even with AM/PM display)  

m  the minute without a leading zero (0 to 59)  

mm  the minute with a leading zero (00 to 59)  

s  the second without a leading zero (0 to 59)  

ss  the second with a leading zero (00 to 59)  

z  the milliseconds without leading zeroes (0 to 999)  

zzz  the milliseconds with leading zeroes (000 to 999)  

AP or A  interpret as an AM/PM time. AP must be either "AM" or "PM".  

ap or a  Interpret as an AM/PM time. ap must be either "am" or "pm".  

https://mikrodev.miraheze.org/w/index.php?title=Qdate.html&action=edit&redlink=1
https://mikrodev.miraheze.org/w/index.php?title=Qdate.html&action=edit&redlink=1
https://mikrodev.miraheze.org/w/index.php?title=Qdate.html&action=edit&redlink=1
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6 ViewPLUS Application Notes 

6.1 Creating a Constantly Increasing Counter Tag 

In some cases, it may be desirable that the trend of the tag value read from the field is 

continuously increasing (such as reading a counter). In such cases, when the data read from the 

field is contaminated because of device replacement, project update, and etc.; trends and counter 

total values may also get contaminated. To prevent this, a mechanism on SCADA can be 

configured in the following way.  

 We need 3 seperate tags to solve the problem. As an example we will create a 

"CounterTag" tag. In parallel we will create a "CounterTag_latest" tag under 

"Database Channel" and a "CounterTag_controller" tag under Macro channel to fix 

field-based distortions so that this tag can read the latest value logged in the 

database. 

 

 We will use the following query in the tag settings to get the most current value we 

have logged into the "CounterTag_latest" tag: 

select dataval from logs.lct_table where tag_id=2 This query will read the last logged 

value of the "CounterTag" tag with tag ID "2"  

 Finally, we will add the control macro to the "CounterTag_controller" tag. The macro 

will be: 
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[v1=$4e0] 
[IF,v1,3] 
[$4=$6+0] 
[E] 
[v0=$4>$2] 
[IF,v0,3] 
[$2=$4+0] 
[E] 
[$4=$2+0] 
[E] 
 

This macro consists of 3 main sections. Lines numbered 1 reads the last logged value from the 

database when the server is running for the first time. Line 2 sets the value to be the value on the 

field device if it is less than the last log value for any reason. Lines 3 are the part where macro 

continuously updates the control tag.  

 In order to prevent erroneous logs in addition to the structure created above, the 

"log only while increasing" option should be enabled in the tag logging settings. 

 

 

 

 

 

 

 

 

 


